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Copyright Notice

Copyright 2010-2011 Ashtech. All rights reserved.

Trademarks

All product and brand names mentioned in this pub-
lication are trademarks of their respective holders.

Ashtech Products - Limited Warranty (North, Central 

and South America)

Ashtech warrants their GPS receivers and hardware 
accessories to be free of defects in material and 
workmanship and will conform to our published 
specifications for the product for a period of one year 
from the date of original purchase. THIS WARRANTY 
APPLIES ONLY TO THE ORIGINAL PURCHASER OF 
THIS PRODUCT. 

In the event of a defect, Ashtech will, at its option, 
repair or replace the hardware product with no charge 
to the purchaser for parts or labor. The repaired or re-
placed product will be warranted for 90 days from 
the date of return shipment, or for the balance of the 
original warranty, whichever is longer. Ashtech war-
rants that software products or software included in 
hardware products will be free from defects in the 
media for a period of 30 days from the date of ship-
ment and will substantially conform to the then-cur-
rent user documentation provided with the software 
(including updates thereto). Ashtech's sole obliga-
tion shall be the correction or replacement of the me-
dia or the software so that it will substantially 
conform to the then- current user documentation. 
Ashtech does not warrant the software will meet pur-
chaser's requirements or that its operation will be un-
interrupted, error-free or virus-free. Purchaser 
assumes the entire risk of using the software.

PURCHASER'S EXCLUSIVE REMEDY UNDER THIS 
WRITTEN WARRANTY OR ANY IMPLIED WARRAN-
TY SHALL BE LIMITED TO THE REPAIR OR RE-
PLACEMENT, AT ASHTECH'S OPTION, OF ANY 
DEFECTIVE PART OF THE RECEIVER OR ACCESSO-
RIES WHICH ARE COVERED BY THIS WARRANTY. 
REPAIRS UNDER THIS WARRANTY SHALL ONLY 
BE MADE AT AN AUTHORIZED ASHTECH SERVICE 
CENTER. ANY REPAIRS BY A SERVICE CENTER 
NOT AUTHORIZED BY ASHTECH WILL VOID THIS 
WARRANTY.

To obtain warranty service the purchaser must obtain 
a Return Materials Authorization (RMA) number prior 
to shipping by calling 1-800-229-2400 (North 
America) or 1-408-572-1134 (International) and 
leaving a voice mail at option 3, or by submitting a 
repair request on-line at: http://ashtech.com (fill out 
the RMA request from under the Support tab). The 
purchaser must return the product postpaid with a 
copy of the original sales receipt to the address pro-
vided by Ashtech with the RMA number. Purchaser’s 
return address and the RMA number must be clearly 
printed on the outside of the package.

Ashtech reserves the right to refuse to provide service 
free-of-charge if the sales receipt is not provided or if 
the information contained in it is incomplete or illeg-
ible or if the serial number is altered or removed. 
Ashtech will not be responsible for any losses or dam-
age to the product incurred while the product is in 
transit or is being shipped for repair. Insurance is 
recommended. Ashtech suggests using a trackable 
shipping method such as UPS or FedEx when return-
ing a product for service.

EXCEPT AS SET FORTH IN THIS LIMITED WAR-
RANTY, ALL OTHER EXPRESSED OR IMPLIED 
WARRANTIES, INCLUDING THOSE OF FITNESS 

FOR ANY PARTICULAR PURPOSE, MERCHANT-
ABILITY OR NON-INFRINGEMENT, ARE HEREBY 
DISCLAIMED AND IF APPLICABLE, IMPLIED WAR-
RANTIES UNDER ARTICLE 35 OF THE UNITED NA-
TIONS CONVENTION ON CONTRACTS FOR THE 
INTERNATIONAL SALE OF GOODS. Some national, 
state, or local laws do not allow limitations on im-
plied warranty or how long an implied warranty lasts, 
so the above limitation may not apply to you.

The following are excluded from the warranty cover-
age: (1) periodic maintenance and repair or replace-
ment of parts due to normal wear and tear; (2) 
batteries and finishes; (3) installations or defects re-
sulting from installation; (4) any damage caused by 
(i) shipping, misuse, abuse, negligence, tampering, 
or improper use; (ii) disasters such as fire, flood, 
wind, and lightning; (iii) unauthorized attachments 
or modification; (5) service performed or attempted 
by anyone other than an authorized Ashtechs Service 
Center; (6) any product, components or parts not 
manufactured by Ashtech; (7) that the receiver will 
be free from any claim for infringement of any pat-
ent, trademark, copyright or other proprietary right, 
including trade secrets; and (8) any damage due to 
accident, resulting from inaccurate satellite trans-
missions. Inaccurate transmissions can occur due to 
changes in the position, health or geometry of a sat-
ellite or modifications to the receiver that may be re-
quired due to any change in the GPS. (Note: Ashtech 
GPS receivers use GPS or GPS+GLONASS to obtain 
position, velocity and time information. GPS is oper-
ated by the U.S. Government and GLONASS is the 
Global Navigation Satellite System of the Russian 
Federation, which are solely responsible for the accu-
racy and maintenance of their systems. Certain con-
ditions can cause inaccuracies which could require 
modifications to the receiver. Examples of such con-
ditions include but are not limited to changes in the 
GPS or GLONASS transmission.)  Opening, disman-
tling or repairing of this product by anyone other than 
an authorized Ashtech Service Center will void this 
warranty.

ASHTECH SHALL NOT BE LIABLE TO PURCHASER 
OR ANY OTHER PERSON FOR ANY INCIDENTAL OR 
CONSEQUENTIAL DAMAGES WHATSOEVER, IN-
CLUDING BUT NOT LIMITED TO LOST PROFITS, 
DAMAGES RESULTING FROM DELAY OR LOSS OF 
USE, LOSS OF OR DAMAGES ARISING OUT OF 
BREACH OF THIS WARRANTY OR ANY IMPLIED 
WARRANTY EVEN THOUGH CAUSED BY NEGLI-
GENCE OR OTHER FAULT OFASHTECH OR NEGLI-
GENT USAGE OF THE PRODUCT. IN NO EVENT 
WILL ASHTECH BE RESPONSIBLE FOR SUCH 
DAMAGES, EVEN IF ASHTECH HAS BEEN ADVISED 
OF THE POSSIBILITY OF SUCH DAMAGES.

This written warranty is the complete, final and ex-
clusive agreement between Ashtech and the pur-
chaser with respect to the quality of performance of 
the goods and any and all warranties and representa-
tions. This warranty sets forth all of Ashtech's respon-
sibilities regarding this product. This limited 
warranty is governed by the laws of the State of Cali-
fornia, without reference to its conflict of law provi-
sions or the U.N. Convention on Contracts for the 
International Sale of Goods, and shall benefit 
Ashtech, its successors and assigns.

This warranty gives the purchaser specific rights. The 
purchaser may have other rights which vary from lo-
cality to locality (including Directive 1999/44/EC in 
the EC Member States) and certain limitations con-
tained in this warranty, including the exclusion or 



limitation of incidental or consequential damages 
may not apply. 

For further information concerning this limited war-
ranty, please call or write:

Ashtech LLC, El Camino Real 451, Suite 210, CA 
95050, Santa Clara, USA, Phone: +1 408 572 
1103, Fax: +1 408 572 1199 or

Ashtech - ZAC La Fleuriaye - BP 433 - 44474 Car-
quefou Cedex - France  Phone: +33 (0)2 28 09 38 
00, Fax: +33 (0)2 28 09 39 39.

Ashtech Products Limited Warranty (Europe, Middle 

East, Africa)

All Ashtech global positioning system (GPS) receiv-
ers are navigation aids, and are not intended to re-
place other methods of navigation. Purchaser is 
advised to perform careful position charting and use 
good judgment. READ THE USER GUIDE CAREFUL-
LY BEFORE USING THE PRODUCT.

1. ASHTECH WARRANTY

Ashtech warrants their GPS receivers and hardware 
accessories to be free of defects in material and 
workmanship and will conform to our published 
specifications for the product for a period of one year 
from the date of original purchase or such longer pe-
riod as required by law. THIS WARRANTY APPLIES 
ONLY TO THE ORIGINAL PURCHASER OF THIS 
PRODUCT. 

In the event of a defect, Ashtech will, at its option, 
repair or replace the hardware product with no charge 
to the purchaser for parts or labor. The repaired or re-
placed product will be warranted for 90 days from 
the date of return shipment, or for the balance of the 
original warranty, whichever is longer. Ashtech war-
rants that software products or software included in 
hardware products will be free from defects in the 
media for a period of 30 days from the date of ship-
ment and will substantially conform to the then-cur-
rent user documentation provided with the software 
(including updates thereto). Ashtech's sole obliga-
tion shall be the correction or replacement of the me-
dia or the software so that it will substantially 
conform to the then- current user documentation. 
Ashtech does not warrant the software will meet pur-
chaser's requirements or that its operation will be un-
interrupted, error-free or virus-free. Purchaser 
assumes the entire risk of using the software.

2. PURCHASER'S REMEDY

PURCHASER'S EXCLUSIVE REMEDY UNDER THIS 
WRITTEN WARRANTY OR ANY IMPLIED WARRAN-
TY SHALL BE LIMITED TO THE REPAIR OR RE-
PLACEMENT, AT ASHTECH'S OPTION, OF ANY 
DEFECTIVE PART OF THE RECEIVER OR ACCESSO-
RIES WHICH ARE COVERED BY THIS WARRANTY. 
REPAIRS UNDER THIS WARRANTY SHALL ONLY 
BE MADE AT AN AUTHORIZED ASHTECH SERVICE 
CENTER. ANY REPAIRS BY A SERVICE CENTER 
NOT AUTHORIZED BY ASHTECH WILL VOID THIS 
WARRANTY.

3. PURCHASER'S DUTIES

To obtain service, contact and return the product 
with a copy of the original sales receipt to the dealer 
from whom you purchased the product.

Ashtech reserves the right to refuse to provide service 
free-of-charge if the sales receipt is not provided or if 
the information contained in it is incomplete or illeg-
ible or if the serial number is altered or removed. 
Ashtech will not be responsible for any losses or dam-

age to the product incurred while the product is in 
transit or is being shipped for repair. Insurance is 
recommended. Ashtech suggests using a trackable 
shipping method such as UPS or FedEx when return-
ing a product for service.

4. LIMITATION OF IMPLIED WARRANTIES

EXCEPT AS SET FORTH IN ITEM 1 ABOVE, ALL 
OTHER EXPRESSED OR IMPLIED WARRANTIES, 
INCLUDING THOSE OF FITNESS FOR ANY PARTIC-
ULAR PURPOSE OR MERCHANTABILITY, ARE 
HEREBY DISCLAIMED AND IF APPLICABLE, IM-
PLIED WARRANTIES UNDER ARTICLE 35 OF THE 
UNITED NATIONS CONVENTION ON CONTRACTS 
FOR THE INTERNATIONAL SALE OF GOODS. 

Some national, state, or local laws do not allow limi-
tations on implied warranty or how long an implied 
warranty lasts, so the above limitation may not apply 
to you.

5. EXCLUSIONS

The following are excluded from the warranty cover-
age: 

(1) periodic maintenance and repair or replacement 
of parts due to normal wear and tear; 

(2) batteries; 

(3) finishes; 

(4) installations or defects resulting from installa-
tion; 

(5) any damage caused by (i) shipping, misuse, 
abuse, negligence, tampering, or improper use; (ii) 
disasters such as fire, flood, wind, and lightning; (iii) 
unauthorized attachments or modification; 

(6) service performed or attempted by anyone other 
than an authorized Ashtechs Service Center; 

(7) any product, components or parts not manufac-
tured by Ashtech, 

(8) that the receiver will be free from any claim for 
infringement of any patent, trademark, copyright or 
other proprietary right, including trade secrets 

(9) any damage due to accident, resulting from inac-
curate satellite transmissions. Inaccurate transmis-
sions can occur due to changes in the position, 
health or geometry of a satellite or modifications to 
the receiver that may be required due to any change 
in the GPS. (Note: Ashtech GPS receivers use GPS or 
GPS+GLONASS to obtain position, velocity and time 
information. GPS is operated by the U.S. Govern-
ment and GLONASS is the Global Navigation Satel-
lite System of the Russian Federation, which are 
solely responsible for the accuracy and maintenance 
of their systems. Certain conditions can cause inac-
curacies which could require modifications to the re-
ceiver. Examples of such conditions include but are 
not limited to changes in the GPS or GLONASS trans-
mission.).

Opening, dismantling or repairing of this product by 
anyone other than an authorized Ashtech Service 
Center will void this warranty.

6. EXCLUSION OF INCIDENTAL OR CONSEQUEN-
TIAL DAMAGES

ASHTECH SHALL NOT BE LIABLE TO PURCHASER 
OR ANY OTHER PERSON FOR ANY INDIRECT, IN-
CIDENTAL OR CONSEQUENTIAL DAMAGES WHAT-
SOEVER, INCLUDING BUT NOT LIMITED TO LOST 
PROFITS, DAMAGES RESULTING FROM DELAY OR 
LOSS OF USE, LOSS OF OR DAMAGES ARISING 
OUT OF BREACH OF THIS WARRANTY OR ANY IM-



PLIED WARRANTY EVEN THOUGH CAUSED BY 
NEGLIGENCE OR OTHER FAULT OFASHTECH OR 
NEGLIGENT USAGE OF THE PRODUCT. IN NO 
EVENT WILL ASHTECH BE RESPONSIBLE FOR 
SUCH DAMAGES, EVEN IF ASHTECH HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAG-
ES.

Some national, state, or local laws do not allow the 
exclusion or limitation of incidental or consequential 
damages, so the above limitation or exclusion may 
not apply to you.

7. COMPLETE AGREEMENT

This written warranty is the complete, final and ex-
clusive agreement between Ashtech and the pur-
chaser with respect to the quality of performance of 
the goods and any and all warranties and representa-
tions. THIS WARRANTY SETS FORTH ALL OF 
Ashtech'S RESPONSIBILITIES REGARDING THIS 
PRODUCT. 

THIS WARRANTY GIVES YOU SPECIFIC RIGHTS. 
YOU MAY HAVE OTHER RIGHTS WHICH VARY 
FROM LOCALITY TO LOCALITY (including Directive 
1999/44/EC in the EC Member States) AND CER-
TAIN LIMITATIONS CONTAINED IN THIS WARRAN-
TY MAY NOT APPLY TO YOU.

8. CHOICE OF LAW.

This limited warranty is governed by the laws of 
France, without reference to its conflict of law provi-
sions or the U.N. Convention on Contracts for the In-
ternational Sale of Goods, and shall benefit Ashtech, 
its successors and assigns.

THIS WARRANTY DOES NOT AFFECT THE CUS-
TOMER'S STATUTORY RIGHTS UNDER APPLICA-
BLE LAWS IN FORCE IN THEIR LOCALITY, NOR 
THE CUSTOMER'S RIGHTS AGAINST THE DEALER 
ARISING FROM THEIR SALES/PURCHASE CON-
TRACT (such as the guarantees in France for latent 
defects in accordance with Article 1641 et seq of the 
French Civil Code).

For further information concerning this limited war-
ranty, please call or write:

Ashtech SAS - ZAC La Fleuriaye - BP 433 - 44474 
Carquefou Cedex - France.

Phone: +33 (0)2 28 09 38 00, Fax: +33 (0)2 28 09 
39 39

CAUTION

RISK OF EXPLOSION IF BATTERY REPLACED
BY AN INCORRECT TYPE.
DISPOSE OF USED BATTERIES
ACCORDING TO THE INSTRUCTIONS.
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Introduction

What is ProFlex
500?

Congratulations! You have just acquired the latest dual-
frequency ProFlex 500 GNSS1 receiver from Ashtech!

GNSS have revolutionized control surveys, topographic data 
collection, construction surveying, marine surveying and 
machine guidance and control. Purchasing the right tools for 
a professional job is essential in today's competitive business 
environment. Learning to put these tools to work quickly and 
efficiently will be the focus of this manual.
ProFlex 500 is a flexible, rugged and high-performance 
GNSS receiver integrating the best of today’s technologies, 
including the exclusive BLADE™ algorithms and multi-
constellation (GPS+GLONASS+SBAS) capabilities.

Scope of this
Guide

This guide is designed to help you rapidly familiarize yourself 
with your new equipment. It is more particularly focused on 

land surveying applications, when the ProFlex 500 is carried 

in a backpack and used with a field terminal and FAST 

Survey.
However, other applications (machine guidance and marine 
surveying) are suggested in this guide, for example when 
describing the receiver (connectors, available accessories, 
etc.), and when presenting the different ways of installing the 
receiver. For detailed information about using ProFlex 500 in 
applications other than land surveying implying the use of 
FAST Survey and a backpack, please refer to the ProFlex 500 
Reference Manual.

For the sake of conciseness, only a selection of the many 
ProFlex 500 and FAST Survey functions are presented in this 
guide.
Most notably, in the RTK surveying section, only the use of 
radios is fully described in the implementation of the data 
link. The other solutions are only outlined. For a full 
description of these solutions, please refer to the ProFlex 500 
Reference Manual.
In the Logging Raw Data section, the assumption is made 
that raw data logging takes place simultaneously with the 
RTK field operations, which means the setup and 
configuration of the equipment is as described in the RTK 
surveying section. In fact, post-processed surveys can be 

1.GNSS= Global Navigation Satellite System.
1
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conducted using optimized setups and configurations for 
static, Stop&Go and kinematic surveys. These are also 
discussed in the ProFlex 500 Reference Manual.
Lastly, this guide only introduces a couple of FAST Survey 
functions, which are “Stake Points” and “Store Points”. For 
a detailed and comprehensive description of all the FAST 
Survey functions, refer to the FAST Survey Reference Manual.
2
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System Components Overview

The tables below provide an overview of the different key 
items composing the ProFlex 500. The list of items is 
intentionally limited to those more particularly required to 
operate a temporary base, and a rover in backpack 
configuration. The complete list of items is provided in the 
ProFlex 500 Reference Manual. 
Depending on your purchase and based on the type of survey 
you wish to perform, you may only have some of the listed 
items. Please refer to the packing list for an accurate 
description of the equipment that has been delivered to you.
Ashtech reserves the right to make changes to the items 
listed below without prior notice.

Basic Supply
Item Part Number Picture

ProFlex 500 GNSS Receiver, L1/L2 GPS
ProFlex 500 GNSS Receiver, L1 GPS/Glonass

990622
990621

Cellular antenna (quad-band) 111397

Bluetooth antenna 111403

7.4 V-4.4 Ah Li-ion Battery Pack (rechargeable) 111374

USB Host-to-Device Cable, 0.2 m
Makes ProFlex 500 a USB device.

702104

Ethernet adaptor cable 702426

Serial data cable 700461

Soft transport bag 206410
3
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Optional
Accessories

AC/DC Power Supply Kit (includes external AC 
adapter, battery charger and cable extension for 
powering ProFlex 500 directly from the AC 
adapter)

802064

ProFlex 500 User Documentation CD 501510

Item Part Number Picture

Item Part Number Picture

ASH-661 L1/L2/L5 GNSS antenna,
gain: 38 dB

802135

ASH-660 L1 GNSS antenna,
gain: 38 dB

802133

RTDS Software 990610 (PC software)

DC power kit for port A 802086 (Internal part)

Choice of radio transmitter kits Refer to page 5 See table on 
page 5

Choice of radio receiver kits Refer to page 5 See table on 
page 5

Survey Backpack kit 890309
See table on 
page 6

External reference clock input kit: Consists of 
an internal coaxial cable fitted with a TNC 
female connector (mounted on rear panel), 
and a protective cap for this connector 
(GNSS input #2).

802097
(Coaxial cable 
is an internal 
part)
4
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Optional Transmitter Kits

Optional Receiver Kits

Item Part Number Picture

U-Link TRx, 12.5-
kHz channel band-
width

Transmitter:
802080-10 (0.5/2/4W; 410-430 MHz)
802080-30 (0.5/2/4W; 430-450 MHz)
802080-50 (0.5/2/4W; 450-470 MHz)
Repeater:
802106-10 (0.5/2/4W; 410-430 MHz)
802106-30 (0.5/2/4W; 430-450 MHz)
802106-50 (0.5/2/4W; 450-470 MHz)
Each P/N includes a whip antenna, and an 
antenna bracket. The Y-shaped power/data 
cable is an integral part of the transmitter 
(no connector).

Picture of 
transmitter 
with its cable

Pacific Crest radio 
transmitter,
25-kHz channel 
bandwidth

110972-30 (35 W, 430-450 MHz)
110972-50 (35 W, 450-470 MHz)
Each P/N includes a whip antenna, an 
antenna bracket and an OEM Y-shaped 
data/power cable.

Transmitter 
alone

Item Part Number Picture

U-Link Rx, 12.5 kHz channel 
bandwidth (includes whip 
antenna).

802081-10 (410-430MHz)
802081-30 (430-450 MHz)
802081-50 (450-470 MHz)

(internal part)

PDLRXO receiver kit, 25-kHz 
channel bandwidth (includes whip 
antenna).

802087-35 (430-450 MHz)
802087-55 (450-470 MHz)

(Internal part)
5
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Survey Backpack Kit Option

Item Part Number Picture

“Quick Release” male/TNC-male coaxial cable, 
1.50 meters.

P076500A

“Quick Release” female/TNC-male coaxial 
cable, 0.75 meters.

P076510A

7.4 V-4.4 Ah Li-ion Battery Pack (rechargeable) 111374

Backpack 206247

GNSS Solutions package, includes CD 702081-01

Range pole option for UHF antenna (includes 
0.50-meter pole with 5/8” female adaptor, TNC 
receptacle and TNC-female/TNC-female cable 
extension, 0.80 meter long)

802088

HI Measurement Tool 111146-1
6
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Equipment Description & Basic Functions

Front View

From left to right:

Bluetooth Antenna
A coaxial female connector (reverse SMA type) allowing you 
to connect a Bluetooth antenna for wireless communication 
with a field terminal or other device.

Cellular Antenna
A coaxial female connector (SMA type) allowing you to 
connect a cellular antenna. A cellular antenna is required 
when the ProFlex 500 sends or receives RTK or differential 
corrections data via its internal cellular modem (GSM).
Take care not to swap the Bluetooth antenna and the cellular 
antenna. The picture below shows where the shorter and 
longer antennas should be connected.
7
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USB Host & Device
A nine-contact female connector (Fischer type). Depending 
on how it is configured, the USB port can be used in two 
different ways:
1. For a USB host, such as a mass storage device using 

optional device cable P/N 702103.
2. For a USB device allowing ProFlex 500 to be seen as a 

disk from the computer connected to this port. In this 
configuration, files can be transferred between the 
ProFlex 500’s internal memory and the computer using 
the USB cable provided (P/N 702104).

Display Screen
The display consists of a 128 x 64-pixel, 1.5-inch 
monochrome yellow screen using organic LED technology 
(OLED). 
Used in conjunction with the Scroll button, the display screen 
allows you to view different pages of information. See Display 
Screens on page 14 for a detailed description of the 
information available from this screen.
After a few seconds of inactivity (i.e. Scroll button idle), 
screen luminosity turns from high to low level.

Power button
To turn on the ProFlex 500, hold the Power button pressed 
until the power LED lights up.
To turn off the ProFlex 500, hold the Power button pressed 
until the “Ashtech” screen is displayed. Then release the 
button and wait until the ProFlex 500 shuts down.

Power LED
• This indicator light is off when the ProFlex 500 is off and 

no external power source is connected to the DC power 
input.

• It is on and red when an external power source is present 
at the DC power input and the ProFlex 500 is off.

• It is on and green when the ProFlex 500 is on, regardless 
of whether it is powered from the internal battery or an 
external power source.
8
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Log Button

Press this button briefly to start recording raw data on the 
selected storage medium.
Another short press on this button will immediately stop raw 
data recording.

Scroll button
Press this button briefly to scroll through the different pages 
of information viewed on the screen.
If an alarm is reported on the display screen, a short press on 
the Scroll button will acknowledge the alarm. The Scroll 
button will recover its display scrolling function only after all 
the alarms have been acknowledged this way.
Another function of the Scroll button is to re-activate the 
screen backlight after the latter has automatically been 
turned off. The Scroll button is also used in the firmware 
update procedure.

Rear View

DC Power Input
A Fischer, three-contact, female connector [1] allowing the 
ProFlex 500 to be powered from either the provided AC 
adapter (connect the cable extension between ProFlex 500 
and the end of the AC adapter output cable), or an external 
9- to 36-V DC power source through cable P/N 730477 (cf. 
base setup using an external radio transmitter).

[9] [3] [4] [5] [7] [1]

[6] [8] [2] [10]
9
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GNSS Input #1 
A TNC coaxial female connector [2] allowing you to connect 
a GNSS antenna to the receiver via a coaxial cable.

Serial Data Ports
These are all Fischer, seven-contact, female connectors, each 
allowing a serial connection to an external device.
• Ports F [3] and B [4] are both RS232-only ports
• RS232/422 Port A [5] is a switchable RS232/RS422 port 

(Default is RS232).
As an option (installed at the factory), port A also delivers 
a regulated DC power voltage between pin 1 (+12 V DC) 
and pin 2 (GND) that can be used to power a connected 
device. The DC current available is 0.5 A steady state, and 
1.0 A peak.

UHF Input Option
A TNC coaxial female connector [6] allowing you to connect 
a radio whip antenna. This connector is available only if the 
ProFlex 500 has been fitted with a radio module.

Ethernet Port
A Fischer, seven-contact female connector [7] allowing you to 
connect the ProFlex 500 to a local network (LAN). Through 
this connector, you may remotely control and monitor the 
ProFlex 500 from any computer connected to the Internet. 
Data may also flow through this port, in the same way as 
through a serial port.

GNSS Input #2 Option
A TNC coaxial female connector [8] for a second GNSS 
antenna input (future optional heading mode), or for applying 
an external reference clock. (Connector [8] is missing from 
the rear view above.)
10
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CAN 2.0 Bus
A Fischer, five-contact, female connector [9] allowing you to 
connect the ProFlex 500 to external, NMEA2000-compatible 
equipment via CAN bus. (For future use.)

Earth Terminal
A screw terminal [10] for connecting the receiver chassis to 
Earth.

Electric Isolation
All signals available on the following connectors are optically 
isolated from the receiver’s internal circuitry and chassis 
ground, as well as from each other: 
• Serial ports A, B and F (including DC power output voltage 

on port A)
• Ethernet port
• CAN bus

Buzzer The internal buzzer will sound whenever an error is detected. 
The buzzer will sound six times and then stop. The error icon 
will however continue to blink. To acknowledge the error 
notification, first press the Scroll key to view the error and 
associated code and then press the same button again. 

Battery Model &
Battery

Compartment

The battery used is a 7.4-V DC - 4400 mAh rechargeable 
battery. It is a standard model used in many camcorders.
The battery is housed in a battery compartment accessible 
from above the ProFlex 500. The compartment door can be 
11
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opened by lifting and then turning the quarter-turn finger 
screw counter-clockwise.
The battery will automatically operate as a backup power 
source for the receiver if for some reason the external DC 
source used is removed from the DC power input.

A slide switch is available at the bottom of the battery 
compartment to set the behavior of the receiver after removal 
or failure of the DC power source while the receiver is on:
• Slide switch pushed to the right: Automatic re-start. The 

receiver will automatically be switched on when DC power 
is restored.

• Slide switch pushed to the left: Manual re-start. After 
power is restored, the receiver will stay off. Operator 
intervention is needed to switch the receiver back on. 

Use for example the tip of a pen to slide the switch to the left 
or right.

Special Button
Combinations

• With the ProFlex 500 OFF, pressing the Power, Log and 
Scroll buttons simultaneously for a few seconds will 
restore all the factory settings.

• With the ProFlex 500 OFF and a USB key connected, 
pressing the Power and Scroll buttons simultaneously for 
a few seconds will cause the ProFlex 500 to start a 
firmware upload process. If there is no USB key 
connected or the key does not contain a firmware upgrade, 
then the process will abort after a few seconds.
Because data has to be decompressed on the USB key 
during upgrades, the USB key must be unlocked, with at 
least 10 MBytes of free memory, before starting the 
upgrade.

These button combinations are summarized in the table 
below:

Button 
Combination

ProFlex 500 
State

Function

Power+Log+Scroll OFF Restores Factory Settings.

Power+Scroll OFF Initiates firmware update from USB key.
12
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13

Installation Instructions

Backpack Mount
The ProFlex 500 is secured in a backpack when used as a 
rover for land surveying applications. Securing the receiver 
using the backpack kit is fully described in RTK Rover Setup 
on page 25.

Tripod Mount
In land surveying applications, when used as a roaming base 
mounted on a tripod, the ProFlex 500 can be secured on one 
of the legs of the tripod using the lug located on its bottom 
side.
This type of installation is fully described in Temporary RTK 
Base Setup on page 21.

Bottom Mount
This type of installation is suitable for machine guidance or 
marine applications. The ProFlex 500 is secured from 
underneath the receiver case, using four screws M4.
Preparing the support (a flat plane) on which the receiver will 
be mounted only consists of drilling four holes, forming a 
simple, 100-mm square.
Note that this is a VESA1-compliant mounting scheme.

Cradle Mount
This type of installation is also suitable for machine guidance 
or marine applications. The ProFlex 500 can be secured on a 
cradle of your choice, possibly designed to allow adjustable 
orientation of the receiver front panel.
On both sides of the receiver case are two M4 screws, 
135 mm apart, that can be used for mounting the receiver on 
the chosen cradle.
In this mounting case, the two Ashtech logo plates located on 
either side of the receiver case can either be kept in position 
or simply removed.

1.VESA= Video Electronics Standards Association.

135 mm
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Display Screens

If you press the Scroll button several times, you will see the 
following displays successively.

Power-On Screen When you power on the receiver, the Ashtech logo appears on 
the screen. It is displayed until the receiver has completed its 
auto-test (this takes about 30 seconds).

Then the General Status screen is displayed. 

General Status
Screen

An example of General Status screen is shown below.

This screen displays the following information:

• : Satellite icon [1] (always displayed).
• Number of satellites tracked [2].
• Position solution status [3]:

– NONE: Position not available
– AUTO: Autonomous GPS position
– DGPS: Differential GPS position
– S DGPS: SBAS Differential GPS position
– FLOAT: Float solution
– FIXED: Fixed solution (RTK is operational)
– BASE: Receiver configured as a base.

[1]

[9] [10] [11] [12] [13]

[2] [3] [4]

[5]

[6]

[8]

[7]
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• Number of satellites used [4]: Number of satellites used 
in the position processing, regardless of the current 
position solution status.

• : Data link icon [5]. This icon is displayed only when 
corrections are received.

• Age of corrections [6], in seconds. This value is displayed 
when corrections are received and only after base station 
information has been received (Position status is at least 
“DGPS”).

• Raw data logging icon [7]:

• Percentage of free memory in the storage medium used 
[8].

• : Battery icon [9] with visual indication of remaining 
charge. If an external power source is used (AC adapter or 
external battery), the battery icon will be animated to 
indicate battery charging in progress.

  is displayed when there is no battery in the 
compartment and the receiver is operated from an 
external power source.

• Power status [10].

• Alarm status [11].

Data recording through front panel Log button:
– Blinking: Raw data logging in progress
– Fixed: No raw data logging in progress.
Data recording through sessions:
– Blinking: Raw data logging in progress
– Fixed: No raw data logging in progress.

ATL data recording for advanced diagnosis.

Icon Definition

Percent 
value

Percentage of remaining battery. This indication will flash when 
the remaining energy drops below 5%. When an internal battery is 
used with external power applied, this icon alternates between the 
plug and the percentage of charge on the battery.

Replaces percentage when an external power source is used.

Icon Definition
Alarm detected. Press the Scroll button to view the alarm type. 
Press it again to acknowledge the alarm, which then disappears 
from the list. Unless there is another alarm in the queue, in which 
case you will have to resume the acknowledge sequence, the 
screen then displays the memory screens.

None No alarm detected
15
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• GSM module (modem) status [12]. This may be one of the 
following icons:

• [13]: USB status and/or Bluetooth status and/or Ethernet 
port status. 

Memory Screens From the General Status screen, press the Scroll button to 
access the Memory screens. Memory screens appear 
successively (see examples) at a display rate of about five 
seconds:

Left screen:
• First line: Percentage of free space in the internal 

memory.
• Second line: Number of files currently stored in the 

internal memory.
• Third line: Percentage of free space on the USB mass 

storage device.

Icon Definition
Blank Modem turned off.

Blinking icon: Modem turned on but not initialized yet. Indicates 
signal strength at modem antenna input.
Fixed icon: Modem turned on and initialized (ready for a connec-
tion). Indicates signal strength received at modem antenna input. 
The higher the number of bars, the better the signal.
This icon will show four horizontal bars and an upside down 
antenna when the input signal is zero.

Modem on line.

Icon Definition

USB port connected to active device

Bluetooth active

Ethernet port active

/ /
These three icons will appear successively when the 
USB port, the Ethernet port and Bluetooth are all active.

Blank USB port unconnected, Bluetooth and Ethernet inactive.
16
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• Fourth line: Number of files currently stored on the USB 
mass storage device.

Right screen:
• First line: Total space occupied by the files currently 

stored in the internal memory.
• Second line: Nominal size of the internal memory.
• Third line: Total space occupied by the files currently 

stored on the USB mass storage device.
• Fourth line: Nominal size of the USB mass storage device.

About the “*” symbol:
• It can only appear at the end of the first or third line.
• Where placed, it indicates that this storage medium is 

used for data logging.

What if there is no USB mass storage device connected to the 
receiver?
• Parameters relevant to the USB key size and space used 

and available are void (three dots displayed instead).
• Number of files is forced to “0”.

Receiver
Identification

Screen

From any of the two Memory screens, press the Scroll button 
to access the Receiver Identification screen. See example 
below.

• Receiver Serial Number
• Firmware Version
• Receiver Bluetooth Identifier
• IP Address

Position
Computation

Screen

From the Receiver Identification screen, press the Scroll 
button to access the Position Computation screen. This 
screen displays the latitude, longitude and ellipsoidal height 
of the position currently computed by the receiver. If the 
receiver is a base, the displayed coordinates are set ones (not 
computed ones) representing the reference position assigned 
to the base. See example below for a rover.
17
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The upper line contains the same information as in the upper 
line of the General Status screen.
A new press on the Scroll button will take you back to the 
General Status screen. If however the receiver is fitted with a 
radio receiver or is connected to an external radio transmitter, 
one or two additional display screens will show up before 
pressing the Scroll button takes you back to the General 
Status screen.

These possible two screens show the current radio settings:
• First line: Serial port used, “Rx” for radio receiver or “Tx” 

for radio transmitter, radio type (U-Link, PDL). Extra-
parameter for “Rx”: Power status

• Second line: Channel number, carrier frequency
• Third line: Protocol used (Transparent, Trimtalk, DSNP), 

airlink speed
• Fourth line: Squelch setting (medium, low, high). Extra-

parameters for Rx if a Pacific Crest: “FEC” if forward error 
correction enabled, “SCR” if scrambling enabled.

Screen Backlight The screen backlight is automatically turned off if no key is 
pressed for 1 minute. When the backlight is off, a short press 
on the Scroll button will turn it back on. The Scroll button will 
then recover its usual functions.

Data Transfer
Screen

For more information on the screen displayed when 
downloading files, refer to Downloading Raw Data on 
page 53.
18
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Charging Batteries Before Use

Make sure the battery is fully charged for each ProFlex 500 
you will be using in the field.
Follow the instructions below to charge a battery.

Removing the
Battery from the

ProFlex 500

Unless the battery has already been taken out, do the 
following:
• Open the battery trapdoor, accessible from above the 

ProFlex 500, by lifting and then turning the quarter-turn 
finger screw anticlockwise. This releases the two springs 
located under the battery, pushing the battery slightly 
upward (see picture). 

•  Grab the battery and take it out of the compartment. 

Charging the
Battery

The battery charger comes with a separate universal AC 
adapter fitted with a 1.5-m output cable. The AC adapter 
includes a choice of four different, detachable plug types. 
Follow the instructions below to operate the charger.
• Choose the plug type that is suitable for your country.
• Secure that plug on the AC adapter.
• Connect the cable from the AC adapter to the battery 

charger.
• Give the battery the right orientation with respect to the 

charger [1] (the battery terminals should come into 
contact with the two sets of connectors on the charger), 
then push the battery against the plate and slide it forward 
[2] until it locks into place. 
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• Plug the adapter into an AC outlet. Battery charging starts 
immediately.
For a low battery that’s being charged, you will first see the 
three LEDs switch on and off, one after the other, followed 
by a short period of time when none of the LEDs is on (see 
[3]).
After about two hours of charging, the MED LED will stay 
on [4]. A few minutes later, the HI LED [5], and then the 
MAX LED [6] will also stay on.

• When the three LEDs are on, this means the battery is 
fully charged and can be disconnected from the charger.

Inserting the
Battery in the
ProFlex 500

• Insert the battery into the compartment making sure the 
battery has the right orientation (the battery terminals 
should come into contact with the two sets of connectors 
located at the bottom of the compartment). 

• Close the trapdoor, push the finger screw in tight, and turn 
it fully clockwise.
Note that once it is properly secured, the trapdoor pushes 
the battery against the bottom of the compartment to 
ensure electrical connection of the battery to the ProFlex 
500.
 

[1] [2]

11
2

MED MAXHI

MED MAXHI

[3]

[6]

MED MAXHI
[5]

MED MAXHI
[4]
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Temporary RTK Base Setup

Prerequisites • You will need a tripod and a tribrach (not provided) to 
install the base. You will also need an antenna extension 
pole fitted with a 5/8” male adaptor (not provided but 
available as an Ashtech accessory).

• For a long-range radio link, i.e. more than 1 mile or 
1.6 km, for which the radio antenna should be placed as 
high as possible, it is good practice to install the antenna 
on top of an antenna pole secured on a tripod (neither of 
these items is provided).

• To power the radio, you need an external 9-28 V DC (U-
Link TRx), 10-16 V DC (Radio P/N 800986-x0) or 9-16 V 
DC (Pacific Crest radio) power source. In all cases, using 
a standard 12 V DC battery is a convenient choice. In this 
configuration, the ProFlex 500 can be powered either 
from the same power source (recommended), using cable 
P/N 730477, or from its internal battery.
Powering the ProFlex 500 from the external battery offers 
two advantages: 
1. Operating sessions can be extended significantly.
2. The external battery operates as a trickle charger for 

the ProFlex 500’s internal battery.
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U-Link TRx The connection diagram is as follows. The use of port A is 
recommended on the receiver side. However, any of the other 
serial ports may be used as well.

Mount the different items as shown on the picture.

ProFlex 500
Base

Cable P/N 730477

To
GNSS

Antenna

Po
w

er

Po
rt

 A

G
N

SS
 In

p
u

t U-Link TRx
(P/N 802080-x0)

External 9-28 V
DC Power Source

Fuse (4 A)

+
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Radio P/N 800986 The connection diagram is as follows. Note that, due to the 
limited input voltage range for this radio, only a 12-V battery 
can be used in this setup. Use of port A is mandatory with this 
transmitter.

Mount the different items as shown on the picture.

ProFlex 500
Base

Cable P/N 730477

To
GNSS

Antenna

Po
w

er

Po
rt

 A

G
N

SS
 In

p
u

t

Radio Transmitter
(P/N 800986-x0)

External 10-16 V
DC Power Source

Fuse (4 A)

+
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PacCrest Radio
Link

The connection diagram is as follows. The use of port A is 
recommended on the receiver side. However, any of the other 
serial ports may be used as well.

Mount the different items as shown on the picture.

PDL 35-W
Transmitter

Pacific Crest Data/Power Cable

Radio Antenna

ProFlex 500
Base

Cable P/N 730477

To
GNSS

Antenna

Po
w

er

Po
rt

 A

G
N

SS
 In

p
u

t

External 9-16 V
DC Power Source

Fuse (4 A)

+
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RTK Rover Setup

Prerequisites • Insert a freshly charged battery into the ProFlex 500. 
• Use a range pole fitted with a 5/8” male adaptor at the 

upper end (not provided).
Caution! Use of a non-metal range pole is recommended 
to maintain the performance level of the radio antenna.

• Mount the GNSS antenna at the top of the range pole.
• Connect coaxial cable P/N P076510A to the GNSS 

antenna.
• If a radio link is used with the base, your rover should 

normally have been fitted with the radio receiver kit that 
matches the reception band covered by the radio 
transmitter used at the base.

• If a GPRS connection is used, your rover should normally 
have been fitted with the SIM card that will allow it to 
perform a network connection.
To connect a SIM card, open the trapdoor and remove the 
battery. The SIM card can be inserted in a dedicated 
socket located at the bottom of the compartment. Insert 
the SIM card as shown on the picture.

Preparing the
Backpack

1. Unzip the larger compartment of the backpack.
2. Insert the different cables needed into the backpack. All 

cables can pass through either of the velcro flaps [1] 
located at the top of the backpack.
• GNSS antenna: Insert the TNC end of the 1.50 m 

“Quick Release” cable (P/N P076500A) into the 
backpack through one of the velcro flaps, then make it 
run along the inner edge of the compartment, down to 
where the rear panel of the receiver will be located 
once placed in the backpack.

• Data Link:
If cellular communication is used to receive RTK 
corrections, no special cable is needed.
If a radio is used to receive RTK corrections, insert the 
UHF range pole into the side compartment of the 
backpack. Secure the pole using the short velcro strap 
[2] located on top of the side compartment. Pass the 
attached coaxial cable through a velcro flap [1], then 

1

2

[1]

[2]
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make it run along the inner edge of the main 
compartment, down to where the rear panel of the 
receiver will be located once placed in the backpack.

• Communication with field terminal:
If Bluetooth is used, no special cable is needed.
If wired communication is used, pass the Fischer end 
of serial data cable P/N 700461 (provided) through a 
velcro flap, and again make it run along the inner edge 
of the compartment, down to where the rear panel of 
the receiver will be located once placed in the 
backpack.

3. Anchor all the cables together, inside the compartment, 
using the short velcro straps [3].

4. Insert the ProFlex 500 into the compartment in such a 
way that the rear panel is facing the bottom of the 
compartment [4].

5. Connect all the ends of the cables present at the bottom 
of the compartment to the rear panel. The required 
connections are:
• GNSS cable to GNSS Input #1 (mandatory)
• UHF radio cable to UHF input (if a radio is used)
• Serial data cable to the serial port of your choice (if a 

serial link is used with the field terminal).

6. If needed, connect the following antennas directly to the 
front panel of the receiver:
• Bluetooth antenna, if wireless communication with the 

field terminal is preferred to a serial link.
• Cellular antenna, if the internal cellular modem is used 

to receive RTK corrections.

7. Secure the receiver inside the backpack by tightening the 
three pairs of Velcro straps [5] over the case. If internal 
antennas are used, some straps should be positioned in 

[3]

[4]

GNSS(Radio)

(Field terminal)

[5]
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such a way that the antennas can pass through the slots 
designed into these straps. 

8. Turn on the ProFlex 500 and close (zip) the compartment.
9. Place the backpack on your back.
10.Connect the free ends of the quick-release coaxial cables 

together. This connects the GNSS antenna to the receiver.
11.Secure your field terminal on the range pole and turn it 

on. You are now ready to start using your system.

If you are using an external cell phone for acquiring RTK 
corrections, place it in the mesh pocket [6] located on the 
left-hand belt of the backpack.

[6]
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Getting Started With FAST Survey

Registering as a
FAST Survey User

The first time you start FAST Survey, you will be prompted to 
register your license of the software. If you do not register, 
FAST Survey will remain in demo mode, limiting each job file 
to a maximum of 30 points.

How to Register
FAST Survey registration is done via the Internet at the 
following address: 

www.survce.com/Ashtech

You will be asked to enter the following information:
• User Name
• Company Name
• Serial Number*
• Email Address
• Phone Number
• Fax Number
• Hardware ID#1*
• Hardware ID#2*
• Reason for Install
• Registration Code*

*: Select Equip>About Fast Survey>Change Registration in FAST 
Survey to read this information.
After you submit this information, your change key will be 
displayed and emailed to the address that you submit. Keep 
this for your permanent records. You may then enter the 
manufacturer and model of your equipment.
If you do not have access to the Internet, you may fax the 
above information to (+1) 606-564-9525. Your registration 
information will be faxed back to you within 48 hours. During 
this time, you may continue to use the program without 
restriction. After you receive your Change Key, enter it and tap 
OK. You can then create a new FAST Survey job, as explained 
further.

Saving your registration in the Field Terminal 
When you register FAST Survey in a MobileMapper CX, a 
ProMark 100 or ProMark 200, the code is automatically and 
safely saved at the end of the registration procedure.
28
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With a Juniper Allegro CX, you need to perform a RAM backup 
or a System Save to be sure your authorization code will not 
be lost when you next reboot your Allegro CX. If you cannot 
find this option on the Allegro CX Start menu, then open the 
Control Panel and choose RAM backup.

Creating a New FAST Survey Job

1. Turn on the field terminal and wait until the boot 
sequence is complete.

2. Make sure the clock is set properly before starting FAST 
Survey.

3. Double-tap  to launch FAST Survey.
4. Tap the Select New/Existing Job button. This opens the 

Coordinate Files window.
5. Tap on the highlighted “crd” file name located at the 

bottom of the screen. This opens FAST Survey’s virtual 
keyboard with the file name now appearing above.

6. Using the keyboard, type in the name of the “crd” file in 
which FAST Survey will store the data you will collect 
during your job.

7. Tap . This takes you back to the Coordinate Files 
window where your file name now appears in the Name 
field.

8. Tap  again. This opens the Job Settings window, which 
consists of five different tabs on which you can set a large 
number of parameters pertaining to the job (or future 
jobs).
Only the parameters that make sense with a GNSS system 
are presented below. All other parameters should be kept 
with their default settings. 
On the System tab:
– Distance: Choose the unit in which all measured 

distances will be expressed (US Survey Feet, Metric or 
International Feet). Unless “Metric” is selected, you 
can also choose the units in which distances will be 
displayed (“Decimal feet” or “Feet and Inches”). 
Warning! You cannot change this setting after creating 

the file!

– Angle: Choose the unit in which all measured angles 
will be expressed (degrees, minutes, seconds or grads)
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– Zero Azimuth Setting: Choose the direction for which 
azimuth is arbitrarily set to 0° (North or South)

– Projection: Choose a projection from the combo box. To 
select a different projection, tap the Edit Projection List 
button. The Add Predefined button allows you to select 
an existing projection. The Add User Defined button 
allows you to create an entirely new projection. The 
selected or created projection will then be selectable 
from the combo box.

On the Stake tab:
– Precision: Choose the number of decimal places (0 to 

5) used to express the three coordinates of any 
stakeout point. “0.000” (3 decimal places) is the best 
setting to fully benefit from the precision offered by 
your equipment.

On the Format tab:
– Coordinate Display Order: Choose the order in which you 

want FAST Survey to display East and North 
coordinates (East, North or North, East).

– Angle Entry and Display: Choose the type of angle FAST 
Survey will display (Azimuth or Bearing).

9. Tap . This creates the file, closes the Job Settings 
window and takes you to the FAST Survey menu.

How FAST Survey
Interfaces With
Your Equipment

Via Bluetooth

First-Time Use
Right after you start FAST Survey and create or open your first 
job, FAST Survey will try to activate the preset connection 
(default: “Cable”) to the receiver. Because no cable is 
connected to the field terminal, a message will be displayed 
informing you that the connection failed.
Assuming your base and rover are nearby and powered on, 
follow the procedure below to perform a Bluetooth connection 
with the base.
• Tap Equip>GPS Base.
• Tap on the Comms tab.
• Select “Bluetooth” from the Type field and, depending on 

the field terminal used, “Ashtech BT” or “Windows 
Mobile” from the Device field.

• Tap on . This opens the Bluetooth Devices window.
• Tap Find Receiver. Wait until FAST Survey lists the 

Bluetooth identifiers of your base and rover. The list 
appears in a new window.
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• Highlight the Bluetooth identifier corresponding to the 
base. To make sure you select the right identifier, press 
the Scroll button on the base until you display the 
Receiver Identification screen. The identifier is in the 
lower line (after the “BT:” prefix).

• Tap . This takes you back to the previous screen where 
the selected Bluetooth identifier remains highlighted in 
the list. The following actions may be performed on the 
selected receiver using the following buttons:
• Set Receiver Name: By default, the “Receiver Bluetooth 

Identifier” of the detected receiver is assigned to this 
parameter. You may use a more self-explanatory name 
to identify your base (e.g.: “MyBase”). 

• Set Receiver PIN: Do not use this button. In its default 
configuration, your equipment does not request a PIN 
code to allow a peripheral device to connect to it via 
Bluetooth.

• Delete Receiver: Removes the selected receiver from the 
list of remote receivers detected by Bluetooth. 

• Tap  to connect the field terminal to the base via 
Bluetooth and then configure the base according to your 
needs (see RTK Base Configuration on page 33).

• Later, you will establish a Bluetooth connection with the 
rover. The process will start when you tap Equip>GPS Rover 
to configure the rover. From the Comms tab, you will be 
able to access the Bluetooth Devices window and select 
the rover receiver from the list of remote receivers 
detected by Bluetooth, in the same way as you did for the 
base.

Switching Between Base and Rover
During a FAST Survey session, you can quickly change the 
receiver you are communicating with (provided the receiver 
you want to communicate with is within Bluetooth range). 

The  icon located in the upper-right corner of the FAST 
Survey window allows you to change receivers. Tap on this 
icon and then:
• Select GPS Base to switch to the base,
• Or select GPS Rover to switch to the rover.

NOTE: If you examine more carefully this icon, you will see 
that it changes aspect (base or rover icon) depending on 
which receiver is currently communicating with FAST Survey.
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In addition, on the Equip menu, a small check box appears in 
the icon inside either the GPS Rover or GPS Base button to 
indicate which connection is active.

Subsequent Uses
In the next sessions of FAST Survey, the software will prompt 
you to re-activate the Bluetooth connection you last 
established in the previous session, or simply work without a 
connection. If you choose the first option, FAST Survey will 
automatically re-establish the connection, provided the 
concerned receiver is still on and within Bluetooth range. 
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RTK Base Configuration

Prerequisites • Your base is properly set up and powered on. It is on its 
definitive location for the survey and the field terminal is 
located at less than 10 metres from the base. 

• Your field terminal is on, FAST Survey is running, a 
Bluetooth connection has already been configured (with 
the base; see How FAST Survey Interfaces With Your 
Equipment Via Bluetooth on page 30) and a job file is 
open.

• In FAST Survey, tap on the Equip tab and then the GPS 
Base button. A message may appear asking you to confirm 
your choice of configuring a base. Tap Yes. This opens the 
Current tab of the GPS Base window.

Set Manufacturer
& Model

• Set the Manufacturer (“Ashtech”) and Model (“ProFlex 
500”) of the equipment used as the base.

Note that the  button beside the Manufacturer field 
allows you to read the following information about the 
connected receiver:
– Firmware version
– Receiver ID
– Power status
– Free memory space
– Firmware options installed.

Tap on  to return to the Current tab.

Check/Change
Bluetooth

Connection

• Tap on the Comms tab. Since the Bluetooth connection 
was performed earlier, just check that FAST Survey is 
properly configured to communicate with the base. You 
should read:
• Type = “Bluetooth”
• Device = “Ashtech BT” or “Windows Mobile”, 

depending on the field terminal used.
• Instr = should be set to the name you gave earlier to the 

base, as seen from FAST Survey Bluetooth.

Note that  located next to the Device field allows you 
to return to the Bluetooth Devices window through which 
you earlier configured the Bluetooth connection to the 
base (see How FAST Survey Interfaces With Your 
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Equipment Via Bluetooth on page 30). Changes can be 
made now if necessary.

Set Receiver
Parameters

• Using the HI measurement tool provided, perform a slant 
measurement of the antenna height (recommended).

• On the field terminal, tap on the Receiver tab.
• In the scroll-down menu, select “[ASH111661] AT...” as 

the antenna type.
• Select the Slant option for the antenna height 

measurement.
• Tap within the Antenna Height field and enter the value you 

have just measured.
• Choose your preferred settings for Elevation Mask, SBAS, 

GLONASS and Virtual Antenna.
Using SBAS and/or GLONASS satellites will help the rover 
maintain the availability of fixed positions in those 
difficult environments where GPS alone would fail to do 
so.
The Virtual Antenna option is disabled by default. Enabling 
the virtual antenna, which is defined as the generic 
“ADVNULLANTENNA” GNSS antenna, allows all 
broadcast differential data and recorded raw data to be 
decorrelated from the GNSS antenna actually used at 
signal reception level. This may be useful when a rover 
from another manufacturer, which does not know the type 
of antenna used at the base, needs to receive RTK 
corrections from this base. 

• Enable Ports B, F and Ethernet: Check this box if one of these 
ports is used for the connection to the radio transmitter. If 
port A is used for this connection and ports B, F and 
Ethernet are not used for other purposes, clear this box to 
disable ports B, F and Ethernet. This will reduce power 
consumption in the receiver.

Set Data Link • Tap on the RTK tab. This tab allows you to set the data link 
on the base side. Several configurations are possible:
1. Using a U-Link TRx device
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Selecting Radio 2. Using radio transmitter P/N 800986-x0
3. Using an external Pacific Crest radio.
4. Using the internal modem in CSD mode for a “phone 

call” type connection (Direct Dial).
5. Using the internal modem for a Direct IP connection to 

the RTDS software.
6. Using an external device connected to ProFlex 500’s 

port A. The external device may be a radio transmitter 
from another manufacturer, or the local computer 
running the RTDS software.

The table below gives all the required settings depending 
on the chosen configuration.

NOTE: All parameters between square brackets [..] are 
software-set, they cannot be changed.

• If you want to use a radio, tap on located next to the 
Device field to set the radio. The table below lists the 
required and recommended settings for the three radio 
models available.

#1
U-Link TRx

#2
Radio P/N 

800986

#3
Pacific Crest 

Radio

#4
Direct
Dial

#5
Direct IP/GPRS

- RTDS

#6
External
Device

Device Ashtech U-Link
Magellan 
Radio

Pacific Crest 
PDL

Internal GSM Internal GSM
Cable or 
Generic Device

Network [None] [None] [None] Direct Dial
“TCP/IP Netw.” or
“UDP/IP Network”

[None]

Port [A] [A]
User-settable
(A, B or F)

[E] [E]
User-settable 
(A, B or F)

Parity [None] [None] [None] [None] [None] [None]

Baud [38400] [19200]
9600 to 115200
User-settable

[19200] [19200]
1200 to 115200
User-settable

Stop [1 bit] [1 bit] [1 bit] [1 bit] [1 bit] [1 bit]

Message 
Type

Choose the format used to generate base data messages: ATOM, ATOM compact, RTCM V3.0, 
RTCM V2.3, CMR or CMR+, (RTCM-DGPS)

Base ID
Choose a number to identify the base. Several ranges are possible depending on the selected data 
format (0-4095 for RTCM 3.0, 0-1023 for RTCM 2.3, 0-31 for CMR and CMR+) 

Field
Model P/N 
800986-x0

U-Link TRx 
Model

Pacific Crest
Radio Model

Protocol -
“Transparent” 
recommended

“Transparent”
recommended

Channel
Choose channel 
used (channel 
No. - Frequency)

Choose channel 
used (channel 
No. - Frequency

Choose channel used 
(channel No. - Frequency)
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The DSNP protocol should be used for the following 
transmitter-receiver combinations:

• If you want to use the internal modem, tap on located  
next to the Device field to set the internal modem. The 
modem settings are listed in the table below:

Over the 
Air Baud

-
4800 Bd recom-
mended

“9600 Bd” recommended

Scram-
bling

- -

In a PacCrest radio trans-
mitter, enables or disables 
scrambling in this radio. 
Keep disabled for other 
radios.

Forward 
Error Cor-
rection

- -

In a PacCrest radio trans-
mitter, enables or disables 
FEC in this radio. Keep dis-
abled for other radios.

Transmitter Receiver
800986-x0 U-Link Rx
800986-x0 PDL
U-Link TRx PDL
U-Link TRx TDRE (Z-Max)

Field
Model P/N 
800986-x0

U-Link TRx 
Model

Pacific Crest
Radio Model

Field Setting

Power
Management

“Automatic” is recommended. In Automatic, the modem is 
automatically powered when you turn on the receiver and will 
only be turned off when you turn off the receiver. In Manual, 
the modem will be powered on only when you configure the 
base.

Band
Select the frequency band used for GSM communications in 
the country where you are. 

Provider

- If you choose Network=” TCP/IP Direct” or Net-
work=”UDP/IP Direct”, choose the name of your mobile com-
munication provider in this field. There are three preset 
providers: Cingular, T-Mobile and MoviStar. If you are using 
another provider, select “Other” in this field and then tap on 
the Settings button underneath to enter the parameters of 
your provider (APN server, APN User Name and APN Pass-
word).
- If you choose Network=”Direct Dial”, ignore this field.

Pin
Enter the Pin number of the SIM card inserted in your 
ProFlex 500.

Dial Mode
“Analog” is usually the right selection at the base. Please call 
your communication provider for more information.
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• If you choose Network=”TCP/IP DIrect” or “UDP/IP 
Direct”, tap on the Config button next to the Network field 
and enter the IP address and port number allowing the 
connection to the RTDS software. 

• If a repeater is used within your system to extend the 
range of the UHF radios used, enable the Repeater Mode 
check box. Enabling this option causes the output rates of 
all the differential messages to be changed into an even 
value (2 sec.) in order to make them compatible with the 
use of the repeater.

• Tap  to load the settings to the radio or modem. This 
may take a few seconds. FAST Survey then returns to the 
GPS Base configuration window.

Load Configuration
to the Base

Now that you have browsed all the tabs in the Base 
Configuration window and set all the parameters, just tap  
to connect and load the configuration to the base. This may 
take a few seconds.

Set Base Position FAST Survey then asks you to set the base position. 
Depending on the chosen method, follow the instructions 
displayed on the screen to define this position. This 
completes the base configuration phase.

Auto Dial Keep this box disabled for a base.

Field Setting
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RTK Rover Configuration

Prerequisites • Your rover is properly set up and powered on. 
• Your field terminal is on, FAST Survey is running and a job 

file is open.
• In FAST Survey, tap on the Equip tab and then the GPS 

Rover button. A message may appear asking you to 
confirm your choice of configuring a rover. Tap Yes. This 
opens the Current tab of the GPS Rover window.

Set Manufacturer
& Model

• Set the Manufacturer (“Ashtech”) and Model (“ProFlex 
500”) of the equipment used as the rover.

Note that the  button beside the Manufacturer field 
allows you to read the following information about the 
connected receiver:
– Firmware version
– Receiver ID
– Power status
– Free memory space
– Firmware options installed.

Tap on  to return to the Current tab.

Set Bluetooth
Connection

• Tap on the Comms tab.
• In the Type field, select “Bluetooth”.
• In the Device field, select “Ashtech BT” or “Windows 

Mobile” depending on which field terminal is used.

• Tap on  to access the Bluetooth Devices window. The 
window lists Bluetooth identifiers that correspond to the 
receivers found in the vicinity.

• Select the rover’s Bluetooth identifier from the list. To 
make sure you are making the right selection, press the 
Scroll button on your rover until you display the Receiver 
Identification screen. The Bluetooth identifier is shown in 
the last line but one. This is the parameter you must select 
from the list.
You may give the rover a more familiar name (e.g. 
“MyRover”) using the Set Receiver Name button. 
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• Tap  to connect the field terminal to the rover via 
Bluetooth. FAST Survey then returns to the GPS Rover 
configuration window.

• Check that the rover name is now selected in the Instr 
field.

Set Receiver
Parameters

• Measure or read the length of the range pole on top of 
which the ProFlex 500 GNSS antenna is mounted.

• On the field terminal, tap on the Receiver tab.
• In the scroll-down menu, select “[ASH111661] AT...” as 

the antenna type.
• Select the Vertical option for the antenna height 

measurement.
• Tap within the Antenna Height field and enter the value you 

have just measured or read for the range pole length.
• Choose your preferred settings for Elevation Mask, 

Ambiguity Fixing (see table below), SBAS, GLONASS and 
Virtual Antenna.

Using SBAS and/or GLONASS satellites helps to maintain 
the availability of fixed positions in those difficult 
environments where GPS alone would fail to do so.
The Virtual Antenna option is disabled by default. Enabling 
the virtual antenna, which is defined as the generic 
“ADVNULLANTENNA” GNSS antenna, allows all 
collected data to be decorrelated from the GNSS antenna 
actually used at signal reception level. This may be useful 
if you wish to post-process the collected raw data using 
base raw data collected with a base from another 
manufacturer.

• Enable Ports B, F and Ethernet: Check this box if one of these 
ports is used for the connection to the radio transmitter. If 
port A is used for this connection and ports B, F and 
Ethernet are not used for other purposes, clear this box to 
disable ports B, F and Ethernet. This will reduce power 
consumption in the receiver.
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Choice Definition

Float
Choose this option if you only need decimeter accuracy (position 
status will never go to “Fixed”).

95.0 95% confidence level
99.0 99% confidence level (default and recommended setting)
99.9 99.9 confidence level
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Set Data Link • Tap on the RTK tab. This tab allows you to set the data link 
on the rover side, in accordance with the base or network 
you will be working with. Several configurations are 
possible:
1. Using the internal radio receiver.
2. Using the internal modem in CSD mode for a “phone 

call” type connection with the base (Direct Dial).
3. Using the internal modem in Direct IP mode (TCP/IP 

or UDP/IP) to receive base data from either a third-
party network or the remote RTDS software.

4. Using the internal modem for a network connection 
(NTRIP or SpiderNet).

5. Using an external CDMA cell phone for a network 
connection (Direct IP, NTRIP or SpiderNet).

6. Using an external device (for example an external 
corrections receiver).

The table below gives all the required settings depending 
on the chosen configuration.

NOTE: All parameters between square brackets [..] being 
software-set, they cannot be changed.

• If you want to use the internal radio, tap on  next to 
the Device field to set the radio receiver:

#7
Internal 
Radio

#8
Internal 
Radio

#9
Direct 
Dial

#10
Direct IP

GPRS

#11
Network,

GPRS

#12
Network,

CDMA

#13
External 
Device

Device
Ashtech 
U-Link 

Pacific 
Crest

Internal 
GSM

Internal GSM Internal GSM
Data Collector 
Internet

Cable or 
Generic Device

Network [None] [None]
Direct 
Dial

“TCP/IP Direct”, 
or “SpiderNet”

NTRIP

“NTRIP”, “TCP/IP 
Direct”, “UDP/IP 
Direct” or “Spi-
derNet”

[None]

Port [D] [D] [E] [E] [E] User settable

Parity [None] [None] [None] [None] [None] [None]

Baud [38400] [38400] [19200] [19200] [19200]
1200 to 115200
User-settable

Stop [1 bit] [1 bit] [1 bit] [1 bit] [1 bit] [1 bit]

Send 
Rover..

This option should be enabled only when working with networks offering VRS capability (NTRIP).
40



E
n
g
li
sh
Then tap  to load the settings to the radio. This may 
take a few seconds. FAST Survey then returns to the GPS 
Rover configuration window.

• If you want to use the internal GSM modem, tap on  
next to the Device field to set the internal modem.
The modem settings are listed in the table below:

Field Setting

Protocol
Select “DSNP” if the radio transmitter used at the base is 
radio model P/N 800986-x0. Select “Transparent” if it’s a U-
Link TRx or a Pacific Crest radio transmitter.

Power Man-
agement

“Automatic” is recommended. In Automatic, the radio module 
is automatically powered when you turn on the receiver and 
will only be turned off when you turn off the receiver. In Man-
ual, the module will be powered on only when you configure 
the rover.

Channel Choose channel used (Channel No. - Frequency)

Squelch

The factory default setting of “High” provides maximum effec-
tive sensitivity to incoming signals.This is the preferred set-
ting.
“Medium” and “Low” sensitivity settings are available for use 
if local electrical noise or distant radio signals falsely activate 
the radio receiver. Use of these settings may reduce the 
radio range.

Over the Air 
Baud

Forced to “4800” with DSNP protocol; “9600 Bd” recom-
mended with other protocols; “7600 Bd” for U-Link.

Scrambling
Relevant to Pacific Crest radios only. Set this parameter as 
set at the base if it uses a Pacific Crest transmitter. For 
another radio used at the base, keep this option disabled.

Forward 
Error
Correction

Relevant to Pacific Crest radios only. Set this parameter as 
set at the base if it uses a Pacific Crest transmitter. For 
another radio used at the base, keep this option disabled.

Field Setting

Power
Management

“Automatic” is recommended. In Automatic, the modem is 
automatically powered when you turn on the receiver and will 
only be turned off when you turn off the receiver. In Manual, 
the modem will be powered on only when you configure the 
rover. “Automatic” is mandatory if “Auto Dial” is enabled.

Band
Select the frequency band used for GSM communications in 
the country where you are. 
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• If you want to use a CDMA cell phone, you should first 
establish and then pair a Bluetooth link between that cell 
phone and your field terminal, using Bluetooth Manager. 
Then, you should use the Network and Dial-up 
Connections utility in your field terminal to connect it to 
the Internet. The incoming corrections will be 
automatically transferred to the ProFlex 500.

• When this button is visible, tap on  next to the 
Network field, for additional settings. The table lists all the 
parameters that need to be defined, depending on the 
desired operating mode.

• Tap  to load the settings to the radio or modem. This 
may take a few seconds. FAST Survey then returns to the 
GPS Rover configuration window.

Provider

- Choose the name of your mobile communication provider in 
this field. There are three preset providers: Cingular, T-
Mobile and MoviStar. If you are using another provider, select 
“Other” in this field and then tap on the Settings button 
underneath to enter the parameters of your provider (APN 
server, APN User Name and APN Password).
- If you set Network=Direct Dial, ignore this field.

Pin
Enter the Pin number of the SIM card inserted in your Pro-
Flex 500.

Dial Mode
Depending on the provider, this may be “Analog” or “Digital”. 
“Analog” is usually the right selection. Please call your com-
munication provider for more information

Auto Dial

Check this box when the data link is based on a GSM con-
nection in CSD mode between the base and the rover.
Check this box as well if you wish that after a power cycle, 
the receiver can connect automatically to the last used 
NTRIP mount point or last used Direct IP server.

Parameter
TCP/IP Direct
UDP/IP Direct

NTRIP SpiderNet
Direct Dial

(CSD mode)

Name • • • •

IP Address • • •

Port • • •

User Name • •

Password • •

Phone Number •

Field Setting
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Load Configuration
to the Rover

Now that you have browsed all the tabs in the Rover 
Configuration window and set all the parameters, just tap  
to connect and load the configuration to the rover.

Check that a
“Fixed” Solution is

Now Available

The rover then starts acquiring corrections data from the 
selected base. Note that the rover will automatically 
recognize the format of the received data (ATOM, RTCM2.3, 
RTCM 3, CMR, CMR+, DBEN). Do the following before 
starting your survey:
• In the Equip menu, tap on the Monitor/Skyplot button
• Read the different parameters displayed on the screen. 

You should see the HRMS and VRMS rapidly decrease 
from a few meters to less than 10 to 20 mm, while the 
position status switches from “AUTO” to “FLOAT” and 
finally “FIXED”.

Other screens are available from within the Monitor/Skyplot 
function showing the details of the constellation, of the 
base position and of the RTK position solution:
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In NTRIP and Direct IP modes, a Disconnect/Connect 
button is available on the Ref tab to easily control the 
network connection. There is also a horizontal bar showing 
the GSM signal level until the modem is on-line. The bar 
disappears when the modem is online.
In Direct Dial mode, a Hang up button is available on the 
same tab to terminate the connection with the base.

• Tap  after you have made sure the FIXED position 
status is settled. This takes you back to the FAST Survey 
menu from which you can start your survey.
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RTK Surveying

Uploading
Stakeout Points to
the Field Terminal

In your office, do the following:
• Connect the receiver or field terminal to your office 

computer using the USB data cable. For ProMark 200 or 
ProMark 100, place the receiver on its docking station 
and connect the docking station to the computer via the 
USB cable.

• Make sure ActiveSync is installed on your computer and is 
allowed to perform USB connections. If you do not have 
ActiveSync installed, download the latest version from the 
following web page:

http://www.microsoft.com/windowsmobile/activesync/default.mspx

hhttp://www.microsoft.com/windowsmobile/activesync/
default.mspx

• Run GNSS Solutions on your office computer.
• Open the project containing the stakeout points you want 

to transfer to the receiver or field terminal as your job.
• On the project map view, select all the reference and 

target points making up your job.
• Select Project>Upload Positions to External Device..

• Select RTK Job and FAST Survey data collector.
• Click OK.
• Name the job (e.g. MYJOB). Keep the Selected Targets and 

References option selected and click OK. This opens the 
Data Transfer dialog box.

• In the combo box, select Active Sync and keep Automatic 
transfer enabled.

• Click OK to establish the connection with the receiver or 
field terminal and upload the job (to \My Device\Program 
Files\FAST Survey\Data\).

• After the job has been uploaded, turn off the receiver or  
field terminal, disconnect the USB cable and go to the 
field with your surveying equipment to stake out your 
points.

Staking Out Points 1. Run FAST Survey and open the job containing the points 
you want to stake out.

2. Tap on the Survey tab and then select Stake Points. The 
screen now displayed allows you to stake out points.
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3. On this screen, FAST Survey asks you to choose the point 
you want to stake out. You can either type in its 
coordinates in the Northing, Easting and Elevation fields, or 
select a pre-defined point from the points list (see File> 
Points). You can also define graphically the point by 
tapping on the point on the graphic screen, or define the 
point according to azimuth, slope and horizontal distance.

4. Once you have chosen a point, tap . A graphic screen 
is now displayed to help you head for the point.

Name of 
stakeout point

Coordinates of 
stakeout point

Provides access to point list.
Example of points list:

Provides access to graphic screen

Zoom settings

Next stakeout point

Logs stakeout point

Current status of 
position solution

Name, coordinates of 
stakeout point, quality data, 
deviation data
(Use the up/down arrow 
keys to show/hide this 
information)

Takes you back to the 
point selection screen

Configures general 
case of point logging

Provides access to 
monitor screen

Provides access to 
screen below (Select 
“Text” in menu)

Your current position 
and heading

Stakeout point (target)

GNSS antenna height

Viewing parameters
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Yellow helmet gives
access to Function

Menu!

5. When the distance to the stakeout point is too small to be 
clearly seen on this screen, tap on the surveyor’s helmet 
in the upper-left corner and select Text from the menu that 
pops up.
A new screen appears giving a more accurate view of the 
remaining distance to the stakeout point. (If you want to 
return to the previous screen, just select Graph in the same 
menu.)

When the remaining distance is within the stakeout 
tolerance (this parameter can be changed in 
Equip>Tolerances), markers appear in the four corners of 
the target. You can now set a stake on this point.

6. Tap on the STORE button if you want to store the position 
of this point. You will be notified if the values of HRMS 
and VRMS exceed the tolerances set for these two 
parameters in Equip>Tolerances. A new screen is then 
displayed showing the coordinates of both the staked and 
design points. 

Stakeout point (target)

Provides access to 
previous screen
(Select “Graph” in menu)

Your current position 
and heading

Used to select which 
guidance data to display 
(underneath)

Used to select which 
guidance data to display 
for the point: coordinates 
or quality data

Current status of 
position solution
47



E
n
g
lish
7. Tap  if you agree. The “Point Stored” message appears 
briefly. The screen then comes back to the Stake Points 
screen where you can choose the next point to be staked.

8. After staking out all your points, tap  in the upper-
right corner of the screen to return to the menu.

Logging Points 1. Tap on the Survey tab and then on Store Points. The screen 
now displayed allows you to log all your points.
The figure below summarizes all the functions available 
from that screen.

2. Type in the point name and description in the 
corresponding two fields (see above)

Configures general 
case of point logging

Provides access to 
monitor screen

Your current position 
and heading

Graphic display area

GNSS antenna height

Viewing parameters
Zoom settings

Logging points with 
position averaging

Logging point 
with offset

Logging point 
(general case)

Enter point name 
and description in 
these two fields

Current position and 
related quality figures
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3. Tap on the “A” button
4. Enter the number of readings you want before FAST 

Survey is allowed to compute an average position for this 
point.

For example, type in “5” and tap .
Messages follow successively indicating that the system is 
taking the five requested readings. Then FAST Survey 
displays the average coordinates it has determined for the 
point.

5. Tap  if you agree. The “Point Stored” message appears 
briefly. The screen then shows the location of the point 
together with its name and description.

6. After logging all your points, tap  in the upper-right 
corner of the screen to return to the menu.

Logging a Line 1. On the Survey tab, select the Auto by Interval function. Two 
different modes are possible: Time or Distance.

2. If you choose Distance, enter the horizontal and vertical 
increment value respectively in the X/Y and Z fields, 
according to the chosen unit. If you choose Time, enter the 
increment value, in seconds.

3. Enter a point Id. for the start point in the Starting Pt ID 
field. This field will be incremented by one after each 
point logging. Initially, the Point Id. may only consist of 
letters (e.g. “ABCD”). FAST Survey will then increment 
the Point Id. as follows: ABCD1, ABCD2, etc.

4. Tap  to switch to the graphic screen (see figure below) 
and start logging the series of points along the line.
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The S button lets you instantly log the position of a point.
The pause button allows you to pause data logging in 
continuous mode.
If data logging in continuous mode is paused, you can still 
continue to log points in manual mode using the S button.
Tap the pause button again to resume data logging in 
continuous mode.

If you directly tap  to come back to the main menu, 
data logging in continuous mode is automatically stopped.

Downloading RTK
Points to GNSS

Solutions

• Go back to your office and connect the receiver or field 
terminal to your office computer using the USB data 
cable. For ProMark 200 or ProMark 100, place the 
receiver on its docking station and connect the docking 
station to the computer via the USB cable.

• Run GNSS Solutions on your office computer.
• Open the project in which to add the points from the field.
• Select Project>Download Positions from External Device..

• Select RTK Results and FAST Survey data collector.
• Click OK. This opens the Data Transfer dialog box.
• In the combo box, select ActiveSync, enable Automatic 

Transfer and click OK. This opens a new window listing all 
the jobs stored in the field terminal.

• Select the job you want to download (e.g. “MYJOB”) and 
click OK. This starts the download process.

Zoom settings

Configures general 
case of point logging

Provides access to 
monitor screen

Your current position 
and heading

Graphic display area

GNSS antenna height

Viewing parameters

Used to log a point’s 
position manually

Used to 
pause/resume data 
logging

Current status of 
position solution

Point ID incremented 
automatically

Current position and 
related quality figures
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Vector information relative to surveyed points is available only 
in .rw5 files. FAST Survey saves vector information directly in 
this file format and so does not create O-files that would 
contain such information.
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Logging Raw Data

Introduction You can log raw data in two different ways:
• Standalone: You simply need to use the Log button to start 

and stop raw data logging.
Later, you will however need to do the following manually:
1. Downloading phase: Rename the raw data files 

collected on each site.
2. Post-processing phase: Manually correct all computed 

elevations for the antenna height.

• Using FAST Survey: The Survey>Log Raw GPS function 
allows you to fully control raw data logging. Using this 
method offers three advantages:.
1. Antenna reduction is automatically performed during 

post-processing because of the antenna height value 
(from the receiver properties) stored in the raw data 
files.

2. Ability to name the raw data file and insert time tags.
3. Ability to pause/resume data logging.

By default, raw data is logged to the receiver’s internal 
memory.
Using FAST Survey, you can change the storage medium 
(internal memory or USB memory stick).
The choice of storage medium is then valid for both data 
logging methods (standalone and using FAST Survey). If 
“USB memory stick” is selected and no USB stick is 
connected to the receiver, then no data logging will take 
place.
In both data logging methods, the Raw Data Logging icon on 
the General Status screen will start flashing when a raw data 
file is open for logging.

Raw Data Logging
Methods

Standalone
• Press the Log button to start data logging.
• Press the Log button again when it’s time to stop data 

logging.

Using FAST Survey
• Tap Survey>Log Raw GPS.
• Tap Start File.
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• Set the following parameters:
– Elevation Mask in degrees.
– Check the antenna height value. If it’s wrong, tap the 

Change Ant. button to set the new value.
– Storage medium (internal or USB memory stick). 

Choosing the internal memory is recommended for 
inclement conditions because USB sticks are not 
waterproof. If using a USB stick is necessary, please be 
sure to somehow ensure that it is out of contact with 
water.

– Logging interval in seconds.

• Tap . This starts data logging. From the screen then 
displayed, you can do the following:
– Name the raw data file, mark a particular point or event 

(Tag New Site). 
– Stop data logging (Close File).
– Access the File Manager window in read-only mode 

(File Manager).
– Continue Logging / Pause Logging. Pausing data logging 

means closing the currently open file. Continuing data 
logging means opening a new file. Data logging will 
start immediately based on the parameters set for the 
previous file. 

Combining the two Methods
Combining the two methods is possible.
For example, you can start data logging using FAST Survey. 
Then you can quit FAST Survey and turn off the field terminal 
without disturbing data logging. Later, you will be allowed to 
stop data logging by simply pressing the Log button on the 
receiver front panel.

Downloading Raw
Data

Use a USB mass storage device as a transit storage medium 
to download raw data files from the receiver’s internal 
memory to your office computer.
Important! During a download operation, files are not deleted 
from the receiver but simply copied to the USB mass storage 
device.
After downloading the files to this device, connect the USB 
device to your computer and use your usual browser to copy 
the files to the project folder.
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Using a USB Mass Storage Device
• Connect the USB mass storage device to the receiver via 

the short USB Device cable provided (P/N 702103).
If raw data files are present in the receiver’s internal 
memory, the following icons will automatically appear on 
the display screen:

• To confirm the file transfer, press the Log button. The 
General status screen will re-appear after the file transfer 
is complete.

• To cancel the file transfer, press the Scroll button.
• If you do not press any button within the next 10 seconds, 

the download procedure will be canceled automatically 
and the screen will come back to the previous display.

Using the USB Cable Provided
• Connect the USB cable provided  (P/N 702104) between 

the office computer and the receiver’s USB port. The 
receiver is then seen as a USB device from the office 
computer

• Using Windows Explorer on your office computer, browse 
the receiver’s internal memory for the raw data files. 

• Copy/paste the files to your project folder. Note  that raw 
data files can directly be deleted from the receiver’s 
internal memory through this connection.

Case of Static Survey in Standalone
When static surveys are performed without the field terminal 
and FAST Survey, you must be careful with raw data file 
names. In view of the ATOM naming conventions used and 
the system’s default settings, there is indeed every chance  
that the base file and the rover file have the same name. It is 
good practice to follow this procedure:
1. Download the raw data file from one of the receivers to the 

USB device.
2. Plug the USB device to the office computer, copy the raw 

data file to the project folder and rename the file to reflect 
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the site where the static occupation took place (e.g. 
replace “G____” with “GPREF”)

3. Repeat the previous two steps with the other receiver, 
using a different name for the file (e.g. replace “G____” 
with “GP100”).

Deleting Raw Data
Files

Use FAST Survey to delete raw data files from the receiver 
internal memory.
1. Tap on the Survey tab and then on Log Raw GPS.
2. Tap on File Manager. The screen displays the following 

parameters:
• List of raw data filenames.
• Selected storage medium.
• Free memory available.
• Current number of raw data files in memory.

3. Unless already done, select Internal Mem to list the files 
stored in the internal memory.

4. To delete one file, highlight its name in the list and tap the 
Delete button. To delete all the files, tap Delete All Files.
Important! When the receiver is logging raw data, the file 
being logged cannot be deleted. The file is protected from 
deletion until you close it.
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